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Kroll Version 10 Service Pack 33 Feature Release Notes 
This document is a compilation of new Features in Kroll Version 10 Service Pack 33. The purpose is to keep 

users informed of changes to the software and to help users implement and adapt to those changes.  

 Prerequisite 
As of Kroll Version 10 Service Pack 32, Kroll Windows requires the Microsoft ODBC Driver 17 for SQL (ODBC) 
and Visual C++ Redistributable (C++ Redist) to function properly. This driver is essential for establishing a 
connection between our application and the database server. 
We strongly recommend the installation of the Microsoft ODBC Driver Version 17 and Visual C++ 
Redistributable, on all workstations, prior to installing the Version 10 Service Pack 33 Update. 

 

API V3  
[KRL-11408] Modernize Kroll API 

Feature 
KrollAPIService publishing has been updated to support both v1 and v3 APIs. This feature set is fully documented 

elsewhere. Contact your sales rep for more information.   

Bi-directional Patient Communication (Billable Solution)  
 [KRL-13836] Enable or disable bi-directional communication 

Feature 
You can now enable or disable the refill message type to allow SMS direct responses from the patient back into 

the Kroll system to trigger a fill on refills.  

Feedback settings require setup within PharmacyLink in order to function. Contact the Kroll Sales team for 

assistance in purchasing this feature.  

Once access is enabled, store level feedback can be enabled at the following location: File > Configuration > 

Store > Interfaces > Outbound Communications > Refill Reminder:  
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From this screen you can enable SMS messages when Refills Remaining and when No Refills Remaining.  

[KRL-13841] Processing outgoing messages for 2-way SMS 

Feature 
When a Refill notification message is sent via SMS and 2-way communication is enabled for the message, Kroll 

tracks whether the outbound message was successful and indicates that it is pending a response.  

To open the Outbound Communication Queue, from the Alt+X – Start screen, choose Utilities > Outbound 
Communications > View Queue from the main menu.  
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[KRL-14494] Adjustments to the Outbound Communication queue to support SMS feedback 

Feature 
The Outbound Communication queue for refill notifications has been updated to support SMS responses.   

• The Status field has been renamed to Send Status.  

• The Contact Number column now shows PharmacyLink Managed when the message was sent out from 

PharmacyLink.  

• A Response Status filter has been added so you can see only messages of status Pending Response, 

Response Failed, or Response Received.  

To open the Outbound Communication Queue, from the Alt+X – Start screen, choose Utilities > Outbound 
Communications > View Queue from the main menu.  
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[KRL-14496] 2-way communications | SMS response handling to create refill requests 

Feature 
Kroll now accepts a response from a Refill SMS notification and manages it through the process. The end goal is 

to have all the prescriptions in the bundle end up in the proper queue for refill.  

To view successful and unsuccessful SMS responses, on the Outbound Communications queue, filter for the 

Communication Type SMS and select All. 
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Once a message has been successfully received and processed, Kroll places any Rx(s) listed in the bundle in the 

appropriate medication queues.  

• Refills that have refills remaining go to the To-Do queue. 

• Refills that don't have refills remaining go to the Callbacks queue (if configured as such). 

Refills placed in either queue will have a new Origin of Feedback Response. This origin will be used for 

reporting to track how many refills were successfully refilled from an SMS response vs how many were handled 

by different means. 

Refills generated based on an SMS Response will have the following details:  

• EnteredBy - The PLink network (This is the same as when a refill comes from Plink) 

• ToDo Type - Refill 
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[KRL-14782] 2-way Coms | Adjustments to the outbound communication details screen to support 
SMS Feedback 

Feature 
In order to support the new bi-directional SMS feature in Kroll/PharmacyLink, the Outbound communication 
details screen will display the response status and the response date/time on any SMS feedback enabled 

messages (currently refill reminders).  

To open the Communication Queue – Item Detail screen, double-click on an item in the Outbound 
Communications screen.  

 

When a message is pending a response, the message shows Pending Response in the response status and the 

response date/time is blank. If a message has been received, the message response status shows Response 
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received and the Response Date/Time shows when that response was received. If for some reason the 

response was not able to be processed, the Detailed View will reflect a “Response Failed” error. 

 

[KRL-14862] New report on notification responses 

Feature 
The new Outbound Communications Feedback Report provides a comprehensive overview of patient 

communications, tracking which messages were sent, the responses received, and the success of those 

responses. 

This report can be found in the main menu by choosing Reports > Patient > Outbound Communications 
Feedback.  
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[KRL-14903] Adjustment to the Rx Summary Report to display all refills triggered by SMS 
Responses 

Feature 
The Rx Summary Report has been modified to include adjustments for SMS Responses, allowing the SMS 

column to display the feedback response.  

The Rx Summary Report is found in the main menu under Reports > Rx > Rx Summary.  
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[KRL-14911] 2-way communications | Mask Prescription numbers on outgoing communications 

Feature 
Outbound Communications for refill that are sent to Pharmacylink have a new variable that allows Rx numbers to 

be masked.  

• Display Rx is what is printed on the label. It can include a prefix.  

• Original Rx and RxNum are Rx numbers and can be different lengths. The system will mask appropriate 

parts of the Rx. 

When Kroll triggers an action that will send out a refill notification where Rxs are supported in the PharmacyLink 

template, one of the following templates will be used. This way, the patient sees the notification with masked 

prescription numbers.   

New template Based on Masking rule applied to new template 
rx_num_masked rx_num variable: rx_num_masked 

###3 

###13 

###013 

1###013 

1####013 

1#####013 

orig_rx_num_masked orig_rx_num variable: orig_rx_num_masked 
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###3 

###13 

###013 

1###013 

1####013 

1#####013 

display_rx_num_masked display_rx_num This variable builds the rx_num based on Kroll 

settings and can vary on how it looks.  

display_rx_num_masked will still need to retain the 

string "Rx: " at the beginning. 

The following Masking rules will be applied to the 

variable: display_rx_num_masked, if there is a 

prefix set: 

Rx: 1029-###3 

Rx: 1029-###13 

Rx: 1029-###013 

Rx: 1029-1###013 

Rx: 1029-1####013 

Rx: 1029-1#####013 

If there is no prefix set, the following Masking rules 

will be applied to the variable: 

display_rx_num_masked: 

Rx: ###3 

Rx: ###13 

Rx: ###013 
Rx: 1###013 

Rx: 1####013 

Rx: 1#####013 

Calendar 
KRL-13211 - Create recurring appointments in the calendar 

Feature 
Kroll's new recurring appointments feature allows users to create appointments that automatically repeat based 

on customizable patterns (daily, weekly, monthly, or yearly) and ranges. This functionality streamlines scheduling 



Kroll V10 SP33 Feature Release Notes  15 

for various pharmacy needs, such as vaccine series, infusion regimens, and recurring tasks, enhancing efficiency 

and competitiveness with other pharmacy management systems. 

Changes have been made to the Patient Card (user interface) to incorporate the new fields and improve 

usability. 

• A new Recurrence button has been added to the New Appointment window. This button enables setting up 

repeating appointments  

 
 

• New flexible scheduling patterns include the following:  
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• Daily: Set appointments for every X days or every weekday

 

• Weekly: Schedule for specific days across multiple weeks
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• Monthly: Choose specific dates or patterns

 

• Yearly: Set annual recurring appointments

 

 
• Customizable recurrence settings include the following:  

• Set end conditions: after X occurrences or by specific date 
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• Option for no end date 

• Maximum of 100 recurrences per series 

• Enhanced Calendar Visibility 

• New icon indicator for recurring appointments 

• Updated calendar tile counter showing all appointments  

• Improved appointment tracking on Alt-X – Start screen 

 

[KRL-13524] - Enhanced Appointment Type Selection 

Feature 
The drop-down Appointment type menu in the Kroll calendar New Appointment or Edit Appointment page has 

been replaced by a smart search functionality. This makes it easier to find and select appointment types. 

To open this page, click Calendar > New for a new appointment, or click on an appointment in the calendar to 

edit it.  

 

What's New: 
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• Smart Search Bar: Quickly find appointment types by typing the name or category 

• Real-Time Results: See matching appointments as you type 

• Organized Display: Results show appointment icons, types, and categories in alphabetical order 

• Bilingual Support: Search tooltip available in English and French 

• Intuitive Interface: Clear visual indicators for empty states and loading 

Benefits 

• Faster appointment scheduling 

• Easier navigation through large appointment type lists 

• More efficient workflow for creating appointments, including recurring appointments 

• Improved user experience with visual appointment type identification 

This update streamlines the appointment creation process, making it more efficient to manage various 

appointment types, including recurring appointments for vaccines, infusions, and regular tasks. 

Carrier IDs 
[KRL-15730] Create new Kroll Update to update SK Blue Cross Carrier ID to 46 (Saskatchewan) 

Feature 
Saskatchewan Blue Cross (SK BC) is implementing a new Issuer Identification Number (IIN - formerly known as 

a BIN), new claim service endpoints, and a new Carrier ID effective March 1, 2025. The move to this new service 

and single, nationwide Carrier ID will eliminate pay-direct billing restrictions based on region and/or plan type and 

simplify the current transmission logic for SK BC, regardless of pharmacy location. 

A Kroll Update has been created to grant a seamless transition. When applied, this update performs two key 

changes: 

• Updates the Carrier ID Default Value to ‘46’ for each Saskatchewan Blue Cross subplan in the 

Plans/Pricing Configuration. 

• Updates the Carrier ID to ‘46’ in the Patient Plan Information record for all patients who have the 

Saskatchewan Blue Cross plan. 
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Central Fill  
[KRL-14785] Addition of a column to indicate CF eligibility and CF Packagers 

Feature 
A CF Eligible column has been added to Drug Search screens. The Column will only show when Central Fill 

Module is enabled in Kroll configuration.  

If Central fill is disabled or there is no host with the type Central Fill, this column becomes hidden for any users 

that had it show and is removed from any users’ stored grid view.  

If Central fill becomes enabled and is setup again, the column becomes available to add but is not automatically 

added to the grid. Add or remove the column from the Drug search grid like any other column.  

The CF Eligible column can be sorted alphabetically. It displays Yes when the drug has a packager. Hover over 

a field to view a list of packagers.  

 

Delivery 
[KRL-15085] Rename Intelcom delivery carrier to Dragonfly/Intelcom 

Feature 
Intelcom delivery service has undergone a rebranding to "Dragonfly" across all Canadian provinces except 

Quebec, where it remains as "Intelcom". To accommodate this change, the ‘Intelcom’ delivery Carrier Type in 

Kroll has been updated to 'Dragonfly/Intelcom', ensuring proper representation of both brand names depending 

on the location. 
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DIS 
[KRL-15960] Fill | FDB | Oxyneo Dose Form code was not mapped in Kroll; therefore it was 
showing a blank Form on the DIS/Network Profile 

Improvement 
The formcode for Oxyneo has been added to the FDB database. Now when dispensing Oxyneo, the formcode 

“ERTAB” is sent to DIS and is viewable under the Network Order/Dispense detail screen as Extended Release 

Tablet.    
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[KRL-15532] New update strategy to support updating NB DIS endpoints / certificates (New 
Brunswick) 

Feature 
A new update strategy has been implemented to manage New Brunswick Drug Information System (NB DIS) 
route configurations. This enhancement enables the system to update both the existing NB DIS route's 

certificate and hostname. The ‘NB DIS Endpoint Update’ update ensures a seamless update to secure and 

accurate communication with the New Brunswick Drug Information System. 

To find the certificate, go to File > Adjudication and choose the Routes tab. Double-click New Brunswick DIS 

to open the Adjudication Route Edit page.  
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Exemption 56 Rules 
 [KRL-15220] Update Rx Transfer Out workflow logic to support Exemption 56 rules 

Feature 
During the Pandemic, the rules regarding how prescriptions for controlled substances were to be managed were 

relaxed with the introduction of what has effectively become known as "Exemption 56" at the Federal level.  One 

such rule that was relaxed provided pharmacists with the ability to transfer prescriptions for controlled substances 

under certain conditions.  At the time, Kroll was modified to allow the removal of all built-in restrictions on the 

transfer of prescriptions for controlled substances.  Recently, it was learned that the provinces continued to 

restrict WHO could process the transfer of prescriptions for controlled substances.  To correct this, Version 10 

SP33 introduces a new flag that when activated, will restrict which user types can process this type of 

transfer.  For Kroll customers who received the modifications made during the pandemic, this new flag will be 

ACTIVE upon successful update to Version 10 SP33, and who can perform this action will be restricted.  In the 

small number of stores that did not receive the modifications (the restrictions are still embedded in Kroll), there will 

be no noticeable change in how they manage transfers. 

See https://www.canada.ca/en/health-canada/services/health-concerns/controlled-substances-precursor-

chemicals/policy-regulations/policy-documents/section-56-1-class-exemption-patients-pharmacists-practitioners-

controlled-substances-covid-19-pandemic.html for details.  

https://www.canada.ca/en/health-canada/services/health-concerns/controlled-substances-precursor-chemicals/policy-regulations/policy-documents/section-56-1-class-exemption-patients-pharmacists-practitioners-controlled-substances-covid-19-pandemic.html
https://www.canada.ca/en/health-canada/services/health-concerns/controlled-substances-precursor-chemicals/policy-regulations/policy-documents/section-56-1-class-exemption-patients-pharmacists-practitioners-controlled-substances-covid-19-pandemic.html
https://www.canada.ca/en/health-canada/services/health-concerns/controlled-substances-precursor-chemicals/policy-regulations/policy-documents/section-56-1-class-exemption-patients-pharmacists-practitioners-controlled-substances-covid-19-pandemic.html
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Live Chat 
[KRL-15293] Move the Live Chat button away from actionable keys 

Improvement 
The Chat with Kroll support button was positioned in the middle of the menu bar directly above some of the 

commonly used tabs. When working through flows within the application, users were accidentally clicking the chat 

button causing them to leave their flow and disrupting their work. This button has now moved to the far right of the 

menu bar away from commonly used tabs and buttons. 

 

Ownership Groups 
[KRL-14558] Designating a store’s organization 

Feature 
An Organization field has been added to Kroll Configuration Parameters to allow authorized users to 

designate a store's organization.  
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This change establishes an additional hierarchy layer, providing more options for Kroll to streamline targeted 

software updates. 

[KRL-14902] New access role  

Feature 
The new Organization User role has been created. This role is intended to manage access and permissions at 

the Organization hierarchy. It has the same permissions as the existing Chain User role, but only has access to 

stores that have an Organization set that matches their organization. This role does not have access to stores 

that do not fall within their assigned organization.  

The Organization User has read/write access to all data related to the Organization hierarchy, including reports, 

logs, and configuration settings, and includes visibility into data analytics and performance metrics at the 

Organization level, similar to the data access available to Chain users. 

All actions performed by the Organization User are logged for audit purposes. Logs capture key activities (e.g., 

user creation, permissions modifications) and provide traceability in alignment with compliance requirements. 
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PrescribeIT® V3 
[KRL-71] Add functionality to support several Prescriber types 

Feature 
License OIDs are now translated both when receiving ERxOrders and when processing Doctor Search 

responses. 

When displaying provider search results, Kroll shows the license type and/or role, preferred language, and 

province.  

When searching for a provider, a doctor designation is added, in order to send the proper OID, depending on the 

doctor designation and the province. If there is no mapping for the Doctor designation and province, Kroll shows 

an error message. 

When sending outgoing messages, Kroll populates the proper license OID based on the doctor’s province and 

designation and uses the provider’s preferred language.  

When receiving an order and creating a doctor, the doctor’s designation and province are determined first by the 

OID and then the role.  

On receiving an order and displaying the doctor data, the proper designation is shown in the Role field.  

[KRL-3015] Display a prompt to the user if there is no ExternalDocAddLink when an 
ExternalDocLink is present 

Feature 
Previously for PrescribeIT®, requests coming from the EMR would sometimes result in the PrescribeIT® IDs for 

the provider not properly saving to the patient profile. This was a very common occurrence if the doctor was 

already on the local system, but it was the first time they were sending an electronic prescription.  If the user was 

not proactive and did not add the PrescribeIT® IDs manually, they ended up being lost. The user would then have 

to perform a manual search from the doctor card to properly populate these external IDs. 

This logic has changed. When the Kroll user is triaging an incoming PrescribeIT® request for a provider that is 

already in Kroll but does not have associated PrescribeIT® IDs, the system will automatically display the Doctor 

screen with these External IDs listed. The user can opt to add them at this point if they wish. If they do, the 

system will automatically update the doctor record with these details. 



Kroll V10 SP33 Feature Release Notes  27 

 

[KRL-3242] Add a new option to indicate that a provider does not want eRenewal Requests 

Feature 
A new refill allowed option of No ERenewals has been added to the doctor record.  
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If this option is checked, it will warn the user when creating an electronic Renewal Request for a doctor that is set 

to PrescribeIT®. The warning indicates that the provider does not allow eRenewal Requests. This is a warning 

only, and works exactly the same as it does for No Fax Refills and No Phone Refills. 
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[KRL-13336] When processing a renewal response, display who sent the response as it may not 
be a doctor 

 Feature 
Stores using PrescribeIT® are able to send electronic renewal requests to providers for authorization of a new 

prescription.  In some provinces, Medical Assistants at the clinic have the authority to “deny" or place renewals 

"under review" on behalf of the provider. In those cases, an extra section of the message that is sent to the 

pharmacy contains details about the person actually performing the action. While the provider is still referenced 

as the authorizing physician, the medical assistant is also tagged as the "recorder" of the message. 

When the renewal response is received by Kroll, the person who recorded the response will be appended to the 

Resolve Comments of the Callback record.  This can be viewed via the Renewal Response screen for 

PrescribeIT® requests via the new View Details option. 

 

 [KRL-13337] For eRenewals, the Doctor Role, Specialty and License must be sent if known 

Feature 
In Kroll, users have the ability to assign a Specialty to a doctor. For users of PrescribeIT®, this specialty was not 

being sent to the EMR. One of their requirements is to include this information, if known. The message has been 

updated to ensure that the following details are always populated when required: 
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• Doctor Role 

• Doctor License Number 

• Doctor Specialty 

There were no UI changes made in Kroll to effect this change. It is a message-level update only. 

 

[KRL-13799] Add Kroll configuration option to switch code to a specific version of PrescribeIT® 

Feature 
A new Kroll Configuration option has been added to control the version of PrescribeIT® that a store is on.  The 

options allowed will be v2.0 and v5.0. When the version of Kroll that contains the new v5.0 logic in it is installed, 

the system will default this setting to v2.0, allowing stores and chains to switch their systems to v5.0 on their own 

schedules. 
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 [KRL-15309] 'Prescription indication for use’ is not translated to French on External Rx Order 
screen 

Improvement 
Stores on PrescribeIT® receive medication orders from the provider. The message sent may contain indications 

as to why the patient is taking the medication (e.g. Diabetic). When the order is received in Kroll, all of the details 

sent from the EMR are displayed to the pharmacist. However, when the Kroll session was set to French, it was 

displaying the indications in English. This defect has been addressed. Indications now display as intended based 

on the language of the user session. 

PrescribeIT® V5 
[KRL-13845] Other | Support Middle Name and Suffix for PrescribeIT® 

Feature 
Kroll recently added Middle Name to the patient card. Previous to this, users would often put the middle name in 

the First Name field and use a space to differentiate the two. When sending a message to the PrescribeIT® 

system, Kroll would split out the two first names and send them as First Name and Middle Name automatically. 
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With the addition of the Middle Name field in Kroll, the system has to rework the way in which patient names are 

sent.  Moving forward, the system will now send whatever is in the First Name field as the full first name, and will 

send whatever is in the Middle Name field as the full middle name. 

For users, the suggested course of action is to update the patient card properly and remove the middle name 

from First Name and properly add it to Middle Name. 

In addition to this change, any PrescribeIT® messages that come into the ADT queue will now support the display 

of Middle Name as a separate data entry field. This means being able to update your patient record properly 

when creating or updating a patient via the ADT Wizard. 

The following screens have been updated to display Middle Name as a separate entry: 

• Processing Electronic Rx Orders 

• Electronic Rx Order Processing Details 

• External Rx Order 

• Create New Rx From To Do 

• ERx Order Details 

• ADT Details Summary 

• ADT Wizard 

• ePrescribe Notifications 

The External Rx Order Report has been updated to include Middle Name. 

 [KRL-14185] Reports | Remove the word ‘Print’ from the Script Image Report and External Rx 
Order Report 

Feature 
The name of both the Print External Rx Order Report and the Print Script Image Report currently display the 

word Print in front. This is inconsistent with the naming standard in Kroll. The word Print has been removed from 

the menu option and is now displayed simply as:  

• External Rx Order Report 

• Script Image Report 

Note: Searching for reports by the word Print will no longer find these reports. 
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[KRL-14215] Other | Fix issue where Doctor First Name with three or more spaced names causes 
transmission failure 

Feature 
For stores using PrescribeIT®, there was an issue when sending a message to the clinic where the Doctor's First 
Name in Kroll had three or more names within it. Kroll was parsing the First name to a Given Name field multiple 

times. PrescribeIT® only allows 2 Given names to be sent electronically. Kroll does not store a middle name for 

the doctor, so users often add extra names to the First Name field with a space in between. 

For example, John Jacob Jack would cause three Given Names to be sent, but the switch would reject the 

message because it only allows two. 

Kroll has been updated to only parse the first and second names indicated in the Doctor's First Name field, and 

then send anything beyond three or as part of the second given name. 

So in the example above: John Jacob Jack will now be sent as: 

Given 1 -> John 

Given 2 -> Jacob Jack 

[KRL-14736] Consistent Date Format across Status in Doctor Callbacks Screen 

Improvement 
When a renewal request is sent via PrescribeIT® to a provider, Kroll creates an associated Callback record. The 

Comments are automatically updated with the date that the eRenewal was sent. The date format was displaying 

as DD-MMM-YYYY. However, originally as implemented for faxes, the date format is DD/MM/YYYY.  

The Comment in the callback record has been updated to display in DD/MM/YYYY format for all types of renewal 

requests. 

[KRL-15066] Ensure PrescribeIT® history remains accessible after module deactivation 

Improvement 
Kroll has been enhanced to allow users to view historical messages, prescriptions, and renewals that were sent 

through PrescribeIT®, even after the PrescribeIT® module has been deactivated. Previously, some areas such as 

EPrescribe Log and EPrescribe Notifications became inaccessible after deactivation. Now, if a PrescribeIT® 

interface has ever existed, these areas remain visible in a view-only state when historical data exists. 

The following functionality remains accessible when the PrescribeIT® module is deactivated: 

• EPrescribe Log through Utilities > EPrescribe Log menu option, with all options accessible. 
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• EPrescribe Notifications from F9 - Workflow screen, including Inbox, Outbox, Deleted, Sent, and Drafts 

folders. 

• View, Refresh and Delete options for 'Communication' type notifications (Reply and New Mail removed). 

• View, Refresh, Delete, and Modify Rx options for 'Transmit Failure' type notifications (Resend and New 
Mail removed). 

• View, Refresh and Delete options for 'ERenewal Response' type notifications (Resend and New Mail 
removed). 

• External Interface References, displaying PrescribeIT® Reference IDs, under the View menu in F3 - Patient 
card; users retain delete capability. 

• ERx Orders option under View menu in F3 - Patient card, allowing view and processing of past PrescribeIT® 

orders. Processing these orders will not send PrescribeIT® notifications. 

• View External Interface References, displaying PrescribeIT® Reference ID (CPR ID), under the Doctor 
menu in F7 - Doctor card. Users retain delete capability. 

• External Rx Order option in the F12 prescription filling screen for PrescribeIT® prescriptions. 

• External Rx Order Report from the Reports menu accessible from the Alt+X - Start screen. 

• PrescribeIT® eRenewals in the Callbacks tab of the screen Alt+X - Start screen. 

• F-Call up Rxs functionality in the Rxs To Do (Data Entry) queue of the  F9 - Workflow screen. 

The following features will be removed when the PrescribeIT® module is deactivated: 

• EPrescribe Messages view in F3 - Patient card. 

• Retrieve PrescribeIT® Order option under the Patient menu in the F3 - Patient card. 

• EPrescribe Messages option in the View menu of the F7-Doctor card. 

• EPrescribe button in F7-Doctor card. 

• PrescribeIT® status section in F7-Doctor card. 

• PrescribeIT® as a Delivery Method selection for Renewal Requests. 

• EPrescribe Messages option in the View menu in the F12 prescription filling screen. 
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The No ERenewals field on the F7-Doctor card remains displayed with its state preserved from when 

PrescribeIT® was disabled (PrescribeIT® 3.0 and up only). 

[KRL-17031] Localize ePrescribe Log Transaction Types 

Feature 
Stores on PrescribeIT® are able to view logs of messages sent back and forth from the store to the EMRs. This 

option is accessed from the Utilities menu. This screen displays the transaction type. The Type column was only 

displaying in English, even if the user was in a French session. The UI has been fixed to display the PrescribeIT® 

message type in either English or French, depending on how the User Session language is set. 

[KRL-17742] Other | Update To Do records when eRenewal response received when callback 
manually resolved 

Feature 
Stores on PrescribeIT® are able to send electronic eRenewal requests to a provider. Kroll allows the user to 

manually approve the request if the provider has not yet responded. There is no message sent back, as this is not 

supported via PrescribeIT®. In some cases, even after the request has been approved locally, the provider is still 

able to respond electronically. Today when this occurs, a New Rx is added to the To Do queue, but there is no 

indication to the user that the prescription was already “manually” approved by the store. 

Kroll has been updated to better inform the user as follows: 

• If the provider sends an electronic approval after the user has already manually approved an eRenewal 

renewal, a new To Do record will be created with the To Do Type of “Duplicate eRx”. 

• Selecting this To Do record will present the user with a new screen that indicates the approval has already 

been done, and that the user can either delete the existing request or create a new prescription. 

• In the case where the New Rx is still sitting in the To Do queue, the system will remove that record and 

replace it with the electronic approval (as this the true authoritative response).  

PrescribeIT® V5 | Split Rx 
 [KRL-13966] Split Rx | Integrate Split Rx with non-dispensing functionality within Kroll 

Feature 
Stores configured with PrescribeIT® now allow the user to take a medication order from the provider and split it 

into up to five separate Rxs. To properly support Split Rx, the user must be able to action these split prescriptions 

together. The following changes have been made to the system: 
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• Most workflow screens have been updated with a new View Side-Bar/Menu option called Split Rx Details 

that shows the entire list of split Rxs associated to one medication order.  

 

• The user will be prompted to add all split Rxs when one is selected from the Rx Profile menu and is being 

actioned upon. 

 

Note: This prompt only occurs when the action in context is for the prescription itself, not on an 
individual fill. For example, opting to Modify a split Rx will not prompt the user, but opting to 
Inactivate one will. 

• Cancelling a split Rx will either: 

• Remove it from the split Rx group permanently if the prescription is completely discarded. 
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• Keep it associated to the split Rx group if Unfilled at that time. 

• Copying a split Rx will only allow the user to maintain the split IF the prescription renewal request was a result 

of an electronic order via PrescribeIT®. This could occur in the following ways: 

• The store sent an eRenewal Request to the provider and they responded back with an Approval or a 

Deny & Replace. 

• The provider sent a New Medication Order to the store and the user is creating a new split. 

• The provider sent a Renew Medication Order to the store and the user is maintaining the split. The user 

would still need to create a new split Rx order in this case. 

• If the user manually copies a previously split Rx to a new number, the new prescription will not be part of any 

split and a new split cannot be created. The user will be warned when this occurs.  

[KRL-13967] Split Rx | Add ability to split a prescription into multiple Rxs for incoming PrescribeIT® 
medication requests 

Feature 
A new option has been added to the Create New Rx from To Do screen that appears when a user is processing 

a new medication order received via PrescribeIT®. This option will allow the user to split a prescription into more 

than one medication.  
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This is ideal for situations where a provider has prescribed a medication that does not have an exact product that 

can be associated to it. 

For example, a provider may prescribe Effexor 187.5 MG to a patient. However, this drug does not come in a 

strength of 187.5 MG. Instead, the pharmacist will have to split this prescription into two separate Rxs, one filled 

at 150MG, the other for 37.5 MG.  This way, the patient can take the correct dosage as prescribed. 

In order to support the above, the following changes have been made to the system: 

• The Create New Rx from To Do screen has been updated with new Single Rx and Split Rx modes. In Split 
Rx mode, the user can split a prescription between 2 to 5 different Rxs. 

• As each prescription is filled, the system links them together in the background to ensure that they can be 

treated as a single order. 

• Once the order is complete, the system adds all Rxs into the To Do queue and the same work order. 
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• All split Rxs are linked in the background to maintain the association to each other. 

• The user can alter the split Rx order as each one is filled for the first time. They can access these from the 

Rx's To Do queue later if they do not want to process them all right away. 

• When processing these from the Rx's To Do queue, the system prompts the user on the Prescription Filling 

screen if they wish to process all split Rxs at the same time. 

• When deleting these from the Rx's To Do queue, the system prompts the user if they wish to delete all split 

Rxs at the same time. 

Note: Only prescriptions that have come electronically from the provider via PrescribeIT® can be split. 

[KRL-13968] Split Rx | Integrate Dispense Notifications with Split Rxs 

Feature 
Stores configured with PrescribeIT® send dispense messages to the provider after an electronic medication order 

has been given to the patient. To properly support Split Rxs for PrescribeIT®, the Dispense Notification has 

been updated to properly alert the provider that the original prescription order has been split into multiple 

prescriptions.   

This message is sent automatically to the provider when a prescription is dispensed to the patient in Kroll, either 

through Rx Pickup or when the prescription is tagged as Completed. 

An accompanying Dispense Cancel Notification message is sent when a fill is cancelled by the user in Kroll.  

Again, this is sent in the backend without any user intervention and has been updated to support this new split Rx 

functionality. 

[KRL-13974] Split Rx | Integrate Cancel Prescription messages received from EMRs with Split Rx 

Feature 
Stores configured with PrescribeIT® can receive cancel requests from the provider after receiving an electronic 

medication for a patient. Kroll now allows the user to take a medication order from the provider and split it into 

separate Rxs. To properly support this for PrescribeIT®, the logic when Kroll receives Cancel Rx requests has 

been changed as follows: 

• The system creates one Cancel Rx To Do record for each split Rx group that was created by the pharmacy 

where the initial order has since been cancelled by the provider. 

• The system looks at the split Rx group as a whole to determine how the user should respond back to the 

request.  
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• If all split Rxs were still in the To Do queue, then the user just has to Acknowledge the cancel request. 

 

• If at least one of the split Rxs has been filled and given to the patient (and has no refills left), then the 

system allows the user to cancel the request or to cancel the order. This means all split Rxs will be 

cancelled as well, filled or not. 

 

• If at least one of the split Rxs has been filled and given to the patient (and has refills left), then the 

system allows the user to revoke or cancel the request; this means any that were filled will be inactivated 

and any that were not filled will be removed. 
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In general, the system will behave as if the user is only cancelling one prescription, but will apply the same type of 

logic to all of the split Rxs in the group. 

In all cases above, the system will also send Dispense Cancel Notifications for each fill that is cancelled. 

[KRL-13976] Split Rx | Integrate eRenewal Requests and Responses with Split Rx 

Feature 
Stores configured with PrescribeIT® are able to send electronic renewal requests back to the provider for 

medication orders that were originally sent from the EMR. Recently, the ability to split these medication orders 

into several prescriptions was implemented. 
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In order to properly support these new split Rxs with electronic renewal requests, the following changes have 

been made: 

• Stores can request renewal requests to the EMR for split Rxs with either one of the split Rxs or all of the split 

Rxs in a group. The user cannot submit a partial renewal. 
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• In the case of a single split, the renewal request will reference the one Rx as being requested, while the rest 

are set to Informational. One Callback record is created to track the single request.  
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• In the case of the full split, the renewal request references all Rxs as being requested. Callback records are 

created to track every Rx in the split Rx grouping. 

 

• When creating a renewal request from the Rx Profile, the system warns the user if either only a single Rx 

has been selected, or a sub-set of the entire group. The prompt indicates to the user the correct courses of 

action that should be taken. 
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• If faxing or printing a renewal request for split Rxs, the system takes into account the single split vs full split 

situation. 

• The print-out has been updated to group split Rxs together, with the additional disclaimers that the 

prescription has been split and why. 

• The print-out lists just the one Rx as being requested when a single split is being requested, with a 

reference to the remaining Rxs that are not, so that the provider can understand what the pharmacy has 

done. 

 

• The print-out lists all Rxs as being requested when a full split is being requested.  
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• In a single split situation, the electronic response back from the provider applies to just the one Rx. The new 

prescription added to the To Do queue will no longer be split (although the user can split the new order if 

needed). 

• In a full split situation, the electronic response back from the provider applies to the entire full split Rx group. 

The new prescriptions added to the To Do queue will still be split (and the user can alter the split group as 

needed). 

 [KRL-14220] Split Rx | Add ability to refill split Rxs from Prescription Filling 

Feature 
Stores configured with PrescribeIT® now allow the user to take a medication order from the provider and split it 

into separate Rxs. They must then be able to refill these split prescriptions together. To support this, the following 

changes have been made to the system: 

• The Split Rx icon displays in either the Original Rx or Rx Number column for each Rx Profile screen. If 

both are displayed, the icon displays in the Original Rx column.  

 

• The Split Rx Icon displays for split Rxs added to a work order from Rx Drop Off.  
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• A new Split Rx Details right-click menu option has been added to each Rx Profile screen to allow the user to 

see the entire list of split Rxs associated to one medication order. A PrescribeIT® order can be split up to 5 

times. 

• If the user is tagging a split Rx on any Rx Profile screen, but does not also tag all associated split Rxs at that 

time, the system treats them as if they are part of the same work order and allows the user to refill them as 

well, similar to when using the Rx's To Do queue. 

• If the user is selecting a split Rx from Rx Drop Off, the system prompts the user to add the other split Rxs 

into the same work order. 

• The user can refill all split Rxs as before, however while refilling each one, the system keeps all split Rxs 

together so they are processed in sequential order. 

Note: The user will not be able to use the split Rx feature on refills if the original fill was not split already.  
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PrescribeIT® V5 | Under Review 
[KRL-13093] Under Review | Accept and process a PrescribeIT® 'Under Review' eRenewal 
response 

Feature 
The system has been updated to allow users to update a callback record with an Under Review status.  

 

This status is used to indicate that the provider has responded back to a renewal request but is not yet ready to 

approve or deny it. In these cases, the provider may need further consultation with the patient, or perhaps is 

waiting for lab work to be completed.  For stores connected to PrescribeIT®, this status update can now come in 

electronically from the provider.  This means that any inbound responses to eRenewal Requests will automatically 

update the status to Under Review.  
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This puts the callback record into a Paused state. A few things to note: 

• Callbacks set to Under Review will sit in the Callbacks queue until the provider sends a subsequent 

Approval or Denial. 

• Callbacks set to Under Review can still be manually updated by the user. 

• Callbacks where the Under Review notification came via PrescribeIT® cannot be resent electronically until 

the callback record is either completed or deleted, although a printed version or sending it to a different 

PrescribeIT® provider is allowed.  
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[KRL-13094] Under Review | Process a subsequent eRenewal response for requests that are 
Under Review 

Feature 
Once the provider has determined the correct course of action on a request in an Under Review status, they will 

follow-up with an Approve or a Deny. When this occurs, Kroll will support the following: 

• If the provider Approves the renewal, it sets the Callback record to Doc Okayed and create a new To Do 

record. 

• If the provider Denies the renewal, it sets the Callback record to Doc Refused, and no To Do record is  

created.  

The Doctor Callback screen has been completely updated and changed to be more in line with other Kroll 

screens. A new option was added to allow the user to view the message history of PrescribeIT® renewal requests. 

In previous versions, only the completed Request Renewal screen was visible for PrescribeIT® callbacks. A new 

View Details option has been added to the Renewal request screens to view the above Doctor Callback 

screen. 

 

[KRL-13187] Under Review | Add new Callback type of 'Under Review' for Renewal Requests 

Feature 
A new callback status has been added to the Callbacks queue. The user can mark a renewal request as Under 
Review using either the top menu option or from the right-click menu. This option is useful for cases where the 

provider has responded back to an initial Renewal Request, but cannot approve the medication until they follow-

up with the patient or their care team. In the meantime, the user in Kroll can tag that Renewal Request as Under 
Review, thus notifying all staff at the pharmacy that the provider is taking action on that request. 
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The following additional changes have been made to support this new status: 

• Updated buttons on the main Callback screen  

      

• Flagged Under Review records in ORANGE color 

• Updated ToDo Report to include Under Review as a filter option 
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• Added Request Renewal as an option on the Specific Doctor Callback screen, so users can actually send 

a fax from that screen to the doctor, if needed. 

• Renamed Fax Doctor to Request Renewal on the Callback screen and removed the informational prompt 

that used to appear. 

• Removed the Fax Doctor option from the following screens since it was redundant with the newer Request 
Renewal option: 

• Rx To Do queue 

• Rx In Progress 

• Rx Profile screens 

• NH Cycle Batch Form 
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PrescribeIT® V5 | Deny & Replace 
[KRL-13603] Deny & Replace | Accept and view Deny & Replace eRenewal responses received 
via PrescribeIT® 

Feature 
PrescribeIT® now allows providers to respond to eRenewal requests from pharmacies with a Deny & Replace 

feature. A Deny & Replace occurs when the provider has decided to change the treatment for a medication of a 

patient. The provider can Deny or Refuse the renewal request, and link a replacement prescription to treat the 

patient moving forward.  PrescribeIT® will also allow the provider to indicate up to five different medications to 

replace the previous prescription. 

The following changes have been made to Kroll in order to track these types of responses: 

• A new status called Doc Replaced has been added to the Callbacks screen to flag eRenewal requests 

where the provider responded back with a Deny & Replace. 
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• A new type called Replace Rx has been added to the Rx's To Do queue to flag those prescriptions that are 

new, yet are replacing the previous medication. 

• Updated ToDo Report to include Doc Replace as a filter option  
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[KRL-13605] Deny & Replace | Process replacement prescriptions for Deny & Replace eRenewal 
responses received via PrescribeIT® 

Feature 
Previously, Kroll had no ability to know if a denied prescription had a replacement associated with it. Anyone 

navigating to the Rx's To Do queue would only see New Rxs, without any clear indication that it was also a 

"replacement" prescription. In order to make processing these types of prescriptions clearer, the following 

changes have been made to Kroll: 

• The Rxs To Do screen has been updated to flag these orders as Replace Rx.  
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• The Processing Electronic Rx Orders screen and the Electronic Rx Order Processing Details screen 

have been updated to properly support replacement prescriptions.  

 

• The system will now flag medication order types where the intent is to Deny & Replace the requested 

eRenewal.  
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• The system will default the system to the Copy and Dispense option and link to the denied prescription. If 

there is more than one replacement Rx, then only one can be copied from the denied prescription. 

 

• A new View Response option has been added to the Electronic Rx Order Processing Details screen 

to view the Callback record associated to the initial request. 
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Professional Services  
[KRL-13356] Automatic selection of Special Service Code (SSC = 2) for specific Adaptation fee 
claims (Nova Scotia) 

Feature 
In Nova Scotia, pharmacists can claim a professional service fee with Nova Scotia Pharmacare (MSI) when they 

adapt one or more prescriptions. For these claims, Pharmacare requires a specific Special Service Code (SSC) 
to be included with the information submitted to the plan, based on the reason for the Adaptation. 
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In Kroll, when finalizing an Adaptation for a prescription in the Rx Adaptation screen (accessed through the 

Adapt Rx by Pharmacist function), users have the option to claim a fee for that Professional Service. If a user 

chooses to claim a fee, Kroll automatically creates a Fee For Service prescription with the information from the Rx 
Adaptation screen. 

In June 2024, Pharmacare updated their CPhA (Canadian Pharmacists Association) Claim Standards, specifying 

that claims for the following reasons must be submitted with SSC = 2: 

• Therapeutic substitutions 

• Refusal to fill a prescription for a Drug Monitored by the Nova Scotia Prescription Monitoring Program 

(NSPMP) 

• Changing a prescription for a clinical reason to enhance patient outcomes related to a change in Dose or 

Duration 

Kroll will now auto-populate the appropriate Special Service Code for the MSI plan, when it creates a Fee For 

Service prescription for an Adaptation, based on the Reason for Adaptation chosen in the Rx Adaptation 

screen. This ensures that SSC = 2 is correctly selected for the following reasons: 

• Dose Change 

• Duration Change 

• Refusal to Fill a PMP Monitored Drug 

• Therapeutic Substitution: Drug shortages 

• Therapeutic Substitution: Better patient outcome 

• Therapeutic Substitution: Reduce patient financial impact 

[KRL-14881] Automatically create a Fee for Service claim when performing Pharmacist Extensions 
in NB 

Feature 
Stores in the province of New Brunswick are allowed to submit a Fee for Service claim when extending 

prescriptions in certain circumstances. The store is allowed to submit up to 4 claims per patient, per year.  In 

previous releases, Kroll did not track this for NB sites, nor did it automatically create a proper Fee for Service 

claim. Kroll has been updated as follows: 

• The system will automatically create Fee for Service claims when performing Rx Extensions in NB. 
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• The system will warn the user when a Rationale has been selected that is not covered.  

 

Only the following Rationales are covered: 

• Extending refill(s) during physician absence 

• Emergency supply of medication 

• The system will count the number of prescriptions being adapted in that request and which Rationale is 

selected, and will then determine the proper PIN and Fee for Service record to submit (see chart below): 

Type Number of Prescriptions 
Renewed 

PIN Fee 

Extending refill(s) during 

physician absence 

2 or less  22224000 $10 

3 22224001 $15 

4 or more 22224002 $20 

Emergency supply of 

medication 

2 or less  22224003 $10 

3 22224004 $15 

4 or more 22224005 $20 

 



Kroll V10 SP33 Feature Release Notes  61 

• The system will also check to see how many Fee for Service claims have been done for that patient over the 

past 12 months. The patient is allowed 4. Once that is exceeded, the system will not automatically create the 

FFS claim anymore. 

SMS Messages 
[KRL-14702] Show the message sent to the patient 

Feature 
Previously when sending the user an SMS message in Kroll (Patient > Send Text Message), there was no ability 

for anyone to see what was mentioned in the text message. Users are now able to see free text that was sent to 

the patient by looking at the Outbound Message Details on the patient card. 

 

Translation 
To ensure accuracy and professionalism for French-speaking users, we have revised the French interface. These 

updates correct language errors and enhance consistency with medical terminology used in pharmacy settings. 

French localization updates were applied to various labels, buttons, checkboxes, shortcut commands, table 

headers, and right-click menu options to ensure a more accurate, professional, and user-friendly experience for 

French-speaking pharmacy users: 

• Corrected grammatical errors (e.g., subject-verb agreement, article usage), sentence structure, and awkward 

phrasing in French translations. 
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• Standardized vocabulary, fixed improper syntax, and clarified field labels and messages. 

• Improved consistency and professionalized terminology for workflows, deliveries, verification, scanning, and 

packaging. 

• Adjusted graphical alignment to ensure text fits in provided areas.  

These improvements help provide a clear, localized interface, aligning with professional standards and user 

expectations in French-speaking pharmacies:   

• [KRL-14659] Allergy Section - French label update for Add Drug Button 

• [KRL-14660] Alternate Address Section - Update French Column Headers 

• [KRL-14664] Batches Section - Correct Typo for a Column Header in Table 

• [KRL-14663] Appointments Section - Update Table Title 

• [KRL-14670] Comments Section - Main Screen - Correct French Grammar in Table Title and Column 

Headers 

• [KRL-14682] Charting section - Update French Translations for Charting Test/Biometric Readings options 

• [KRL-14683] Charting section - Update French Translations for Buttons, Tooltips, and Menu Titles 

• [KRL-14685] Demographic Information - Main Screen - Update French Labels for Family Doctor and Birthdate 

Fields 

• [KRL-14689] Demographic Information - Main Screen - Email and Notification Pop-up - Update labels and 

buttons to display accurate French terminology 

• [KRL-14692] ERx orders Section - Add French Translation for Outgoing Orders Checkbox 

• [KRL-14693] Immunization Section - Update French Translations and Fix UI Alignment 

• [KRL-14981] French language fixes on Drug Search page 

• [KRL-14983] French language fixes on Drug card 

• [KRL-15002] Outbound Communication Section - Update French Translations in UI 

• [KRL-15335] Services Configurations - Correction of Grammar and UI Overlap 

• [KRL-15338] Kroll Configuration - Some fields and labels are too short 
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• [KRL-15450] Store-level configuration – General tab 

• [KRL-15452] Active Medication Listing Report 

•  [KRL-15458] Adjudication totals 

• [KRL-15539] French Translation Corrections on Store-Level Configuration (Drug tab) 

• [KRL-15896] Store-level Configuration – Rx tab - Prompting tab 

• [KRL-15901] Store-level Configuration – Rx tab - Nursing Home tab 

• [KRL-15907] Store-level Configuration – Rx tab - Background Rx Filling 

• [KRL-15908] Store-level Configuration – Rx tab - Counselling tab 

• [KRL-15965] Store-level configuration - Rx-Tab -  Workflow Tab 

• [KRL-15984] Store level configuration – RX tab - Immunization tab 

• [KRL-16049] Store-level Configuration – Rx tab- Auto-Refill/Reminders tab 

• [KRL-16135] Store-level Configuration – Vigilance tab 

• [KRL-16171] Store-level Configuration - Adjudication Tab -Retail Tab 

• [KRL-16899] Store-level Configuration - Clean-up Tab 

French-speaking users now see correct and professional French throughout the interface. These updates aim to 

improve the user experience for French-speaking pharmacy staff by using standardized, intuitive terminology that 

is clear, consistent, and correctly formatted and aligned, helping to ensure clear understanding and usability. 

[KRL-15538] Store-level Configuration - Patient Tab 

Improvement 
The following configuration updates were made to the Patient tab to support enhanced functionality and 

localization for Canadian French users. 

• Require Sex on Patient Card 

• EN: Sex is now a required field on the patient card. 

• FR (CA): Exiger le sexe sur la carte du patient 

• Allow Duplicate Quick Codes 
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• EN: The system now allows duplicate quick codes for patient records. 

• FR (CA): Permettre les codes rapides en double 

• Prompt for Patient Privacy Consent (Retail Patients Only) 

• EN: A privacy consent prompt is now enabled for retail patients. 

• FR (CA): Demander le consentement de confidentialité du patient – Pour les patients réguliers 

• Enable Identity Verification 

• EN: Identity verification is now enabled for patients. 

• FR (CA): Permettre la vérification de l'identité 

• Relationships for Authoritative Caregivers: 

• Adults: 

• EN: Relationship tracking is now supported for caregivers of adult patients. 

• FR (CA): Relations pour les soignants autorisés d’un adulte 

• Minors: 

• EN: Relationship tracking is now supported for caregivers of minor patients. 

• FR (CA): Relations pour les soignants autorisés d’un mineur 

Tx Unfill Notification 
[KRL-15011] Adjust the Rx Transfer status if the Drug is unfilled and no Authoritative Image exists 

Improvement 
Previously when transferring an Rx from one store to another, there was no warning given if the transferring store 

did not have an authoritative scan of the Rx prior to transferring. Now when transferring out Rxs from one store to 

another, a warning will appear if the Drug does not have an original/authoritative Rx image attached.  
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[KRL-15012] Always print the Rx Image when Transferring out an Unfilled PharmacyLink Rx 

Improvement 
Previously, when transferring an Rx to another store where there was no authoritative/original Rx received yet by 

a patient, the inclusion of the non-authoritative copy was an option in the transfer. Now, when transferring out an 

Rx to another store where the authoritative Rx isn’t present, the Rx image/scan that is present will ALWAYS be 

included in the transfer.  

[KRL-15015] Adjustment to the Transferred Out report to add a message concerning the original 
for the receiving pharmacy 

Improvement 
Previously, the Transferred Out report did not indicate which Rxs were transferred that didn’t have an 

authoritative/original copy of the Rx. This has been resolved. All Rxs without an authoritative/original scanned 

copy now have a message ‘Authoritative Rx not obtained from patient' on the Transfer Out report. 
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[KRL-15050] Adjustments to the Rx Transfers Report to show non-authoritative Rx(s) present 

Improvement 
Previously, the Rx Transfers report did not indicate which Rxs were transferred that didn’t have an 

authoritative/original copy of the Rx. This has been resolved. All Rxs without an authoritative/original scanned 

copy now have a message ‘Authoritative Rx not obtained from patient' on the Rx Transfer report. 
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[KRL-15482] Check primary Rx image for authority and manage additional images 

Feature 
Kroll evaluates the attached Primary Rx Image to determine whether it is authoritative or non-authoritative. 

If a user modifies or adds a new image to the Rx, if the Primary Script Image is:   

• Unauthoritative: Kroll will make the new Script image added the primary image and retain the previous 

image, but it will no longer be primary.  
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• Authoritative: Kroll will add the new script image and retain the previous image, which will still be primary.  

 

On the Scan Image screen, select Script Image type and click Save. The new image is set as primary on the 

Rx Images screen. If a different type is selected, the new image is added as that type and the script image 

that was present is still the primary. 

If a user modifies an existing image that is non-authoritative, regardless of whether if the Primary Script 

Image is authoritative, Kroll will take the new image and add it as a subsequent image and retain the previous 

image, which will still be primary.  

If the user modifies an existing image that is Authoritative and the Primary Script Image is Unauthoritative, 

Kroll will make the new Script image added the primary image and will retain the previous image, but it will no 

longer be primary. If the Primary Script Image is Authoritative, Kroll will add the new script image and will retain 

the previous image, which will still be primary. 

If a user modifies an existing image that is NOT a script Image, Kroll will add the new image as the selected 

type and retain the previous script image, which will still be primary. 
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[KRL-15868] Display Transfer Rx summary and transfer status when transfer out Rx through 
Modify Rx screen 

Feature 

When transferring an Rx from the Modify Rx screen, the Rx summary and Transfer status now display, and if 

the Rx image is unauthoritative, a notification will appear. 

 

Yardi 
[KRL-12550] Transmit proper TQ1 segments to Yardi (i.e. Administration Timing Segments for 
Passtimes) 

Feature 
Kroll is integrated with Yardi, an application that manages prescription orders for Nursing Home facilities. This 

integration allows participating stores to send new medication orders electronically to the associated facility. This 

message is formatted as an HL7 xml standard. Within that message is a technical segment that codifies the 

administration  times that a medication is to be given to patient at the home.  
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There was a previous issue with Yardi in that some frequencies selected by the user in Kroll were not properly 

populating the HL7 xml message. This issue has been corrected. There are no UI changes in Kroll required to fix 

this, as any messages sent to Yardi occur in the background. The user will not "see" the message, however the 

user can view the xml via the Rx Instructional note on the Prescription Filling screen ("This Rx is linked to an 

eRx”).  

1. Double click the instructional note to open the ERx Details screen.  

2. Select the order to open a Details page. Select Other > View Request.  

This displays the xml message actually sent. The segment in question is called 'TQ1'. 
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